VIDATA 2.0

Programme de lecture et de gestion VIDATA 2.0

&N

Read out and management program VIDATA 2.0
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A l‘aide du programme VIDATA 2.0 les
soudures  documentées peuvent étre
transférées d‘une clé USB vers |‘ordinateur et
ainsi étre traitées et imprimées.

Le programme offre aussi la possibilité
d‘afficher et d‘imprimer le nom du soudeur et
le descriptif du projet en codes-barres. Ceci
permet a l‘utilisateur sur le chantier de
rapidement obtenir les noms ainsi que les
projets, sans erreur.

Le logiciel peut de plus étre utilisé pour les
appareils VULCA VIWEL+ et les machines
VULCA CNC.

2 Installation du logiciel

Le logiciel se trouve sur la clé USB fournie.

Branchez la clé USB dans le port
correspondant de |‘ordinateur.
Ouvrez le fichier Setup (Installation)

choisissez la langue et suivez les instructions
qui s‘affichent.

r =

Langue de I'assistant d'installation @

Veuillez sélectionner la langue qui sera utilisée
par |'assistant d'installation :

)

][ Annuler ]

[Frangais

Ok

1 Caractéristiques 1 Characteristic

The VIDATA 2.0 program is used to transfer
documented welding sequences from a USB
stick to a computer to be processed and
printed out.

The program also offers the option to show
the name of the welder and the designation
of the construction project as a barcode and
to print these out. This allows the user on the
building site to rapidly and read in names and
construction projects error-free.

The software can be used with both the
VULCA VIWEL+ devices as well as for the
VULCA CNC machines.

2 Installation of the software

The software can be found on the attached
USB stick. Please insert the USB stick into the
appropriate port on the computer.

Open the setup file: Select the language you
wish to use and follow the displayed
instructions.

o =]

Bienvenue dans l'assistant
d'installation de VIDATA

35! Installation - VIDATA

Cet assistant va vous guider dans [installation de VIDATA
wversion 2.0 sur votre ordinateur.

1l est recommandé de fermer toutes les applications actives
avant de continuer.,

Cliquez sur Suivant pour continuer ou sur Annuler pour
abandonner ['installation,

| Suvant > | [ Annuler ]

5! Installation - VIDATA

Dossier de destination
Ol VIDATA doit-l &tre installé ?

| L'assistant va installer VIDATA dans le dossier suivant.

Pour continuer, diquez sur Suivant. Si vous souhaitez chaisir un dossier différent,
cliquez sur Parcourir.

C:\Program Files (x38)\WIDATA Parcourir. ..
Le programme requiert au moins 8,4 Mo d'espace disque disponible.
< Précédent ][ Suivant > ] [ Annuler

§5 Installation - VIDATA

[E=5 o >
Sélection du dossier du menu Démarrer
0i1 l'assistant dinstallation doit-l placer les raccourds du programme ?

ol

Cliquez sur Suivant pour continuer. Cliquez sur Parcourir si vous souhaitez sélectionner
un autre dossier du menu Démarrer.

L'assistant va créer les raccourcis du programme dans le dossier du menu
Démarrer indiqué ci-dessous.

VIDATA Parcourir...
|| Ne pas créer de dossier dans le menu Démarrer
< Précédent ][ Suivant > ] [ Annuler
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13! nstallation - VIDATA = & [&5] |§5 mstaliation - VIDATA ol & s

Prét a installer
L'assistant dispose & présent de toutes les informations pour installer VIDATA sur
votre ordinateur,

Taches supplémentaires
Quelles sont les tiches supplémentaires qui doivent Etre effectuées ?

Sélectionnez les tches supplémentaires que l'assistant dinstallation doit effectuer Cliquez sur Installer pour procéder & l'installation ou sur Précédent pour reveir ou
pendant l'installation de VIDATA, puis diquez sur Suivant. madifier une option dinstallation.
Dossier de destination : -

Icdnes supplémentaires :
C:\Program Files (x86) WIDATA

Créer une ictne sur le Bureau
Dossier du menu Démarrer :
VIDATA

Taches supplémentaires :
Icénes supplémentaires :
Créer une icdne sur le Bureau

< Précédent || Suivant > | [ Annuler ] < Précédent || Installer | [ Annuler

=] @ =
Fin de l'installation de VIDATA

35/ Installation - VIDATA

L'assistant a terminé linstallation de VIDATA sur votre
ordinateur. L'application peut &tre lancée 3 [aide des icdnes
créées sur le Bureau par linstallation.

Veuillez diquer sur Terminer pour quitter 'assistant
dinstallation.

3 Paramétrage de la langue 3 Setting the language
La langue par défaut est I'anglais. Pour The language is set to English. If you wish to
modifier la langue, cliquez en haut & gauche change the language, click at the top left on

“Settings” and then on “Language”. You can

sur « Settings » (Parametres), puis sur
then select the desired language.

« Language » (Langues). Vous pouvez ensuite
choisir la langue voulue.

File Info

Language » Deutsch
v English

France

4 Lecture des protocoles de soudure sauvegardés 4 Reading in the saved welding logs

Branchez la clé USB contenant les données
dans le port correspondant de |‘ordinateur.
Si le programme n‘est pas ouvert, lancez

VIDATA 2.0 en double-cliquant sur I‘icone du
programme. Cliquez en haut a gauche sur
« File » (Fichier), puis sur « Read Project »
(Lire projet).

Please insert the USB stick carrying the data
to be transferred over into the appropriate
port on the computer.

Open the VIDATA 2.0 program by double-
clicking on the program symbol if the
program is not already open. Click on “File” at
the top left and then on “Read project”.

|Fi|e| Settings Info

Read project
Print
Exit
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Le gestionnaire de fichier Windows s‘ouvre
alors. Tous les protocoles de soudure
sauvegardés se trouvent dans un fichier sur la
clé USB. En double cliquant sur le nom du
fichier, vous pouvez lire les protocoles de
soudure sauvegardés dans VIDATA 2.0.

Tous les protocoles de soudure lus
apparaissent dans le menu déroulant. Chaque
ligne représente une soudure.

The Windows File Manager opens. All saved
welding logs are located in one file on the
USB stick. Double-clicking on the file name
causes the saved welding logs to be read into
VIDATA 2.0.

The read in welding logs are all displayed in a
dropdown menu. Every line represents one
welding.

File Settings Info

Search

|

Parameter

|

Minimum

Maximum

Search J

]

P,00000050;20140403;1405;Max Mustermal

Aprés avoir choisi une soudure en particulier,
les données sauvegardées sont affichées a
droite sur l‘interface du programme.

Selection of a particular welding sequence
causes the saved data to be displayed in the
right part of the program interface.

“Fie Settings Info

Search
Parameter

Minimum  Maximum Log number

Search

Company

Machine type

Serialnumber
| =

Software version

Next maintenance Latitude

CNC Vous pouvez filtrer les soudures
sauvegardées par date.
VIWEL+ Avec la

(Rechercher), vous pouvez filtrer précisément

fonction « Search »

en fonction de différents paramétres, comme
Chantier/Projet

Weldercode

Construction site /

Date / Time

Temperature / Weather

Longitude

Supply voltage max. Review

Supply voltage min. Remarks
Welding energy

Fittingcode

Traceability

Pipe1 - Traceability

Pipe2 - Traceability

CNC: Saved welding logs can be filtered by
date.

VIWEL+: The “Search” function is used to
filter logs in a targeted manner according to
various parameters such as the building site /
construction project

File Settings Info

Search

Construction site
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Dans le champ « Parameter » (Paramétre), The search can be further refined using the
“Parameter”, “Minimum” and “Maximum”
fields (for example search according to a

certain date or a certain specific project).

« Minimum » et « Maximum », la recherche

peut étre améliorée (par exemple en fonction

d‘une date précise ou d‘un projet spécifique).
File Settings Info

Search

[Construction site ']
Parameter

Minimum Maximum

Search
5 Impression des protocoles de soudure (format pdf) 5 Printing of welding logs (pdf format)

Une fois les données d‘une soudure
spécifique affichées, il est possible de saisir
des commentaires supplémentaires dans le

If data for a selected welding sequence is
displayed there is also the option to insert
additional remarks in the “Remarks” field.

champ « Remarks » (Remarques). Les autres

données ne sont pas modifiables.

Pour créer un protocole de soudure au
format pdf, cliquez sur « File » (Fichier), puis
sur « Print » (Imprimer). Vous pouvez choisir

ici quel(s) protocole(s) imprimer.

Un rapport : Un protocole pdf est créé pour

la soudure téléchargée (visible).

Dans l'intervalle de temps : Un protocole pdf
est créé pour chaque soudure qui a été

consignée au cours d‘une période donnée.
Tous les protocoles :
créé pour toutes les soudures sauvegardées.

Un protocole PDF est

[dossier | paramétres infos

lire projet |
Imprimer  »

Quitter

Other data cannot be altered.

To create a welding log in a pdf format, click

on “File” and proceed to “Print”. Here it is
possible to select which log or logs one
wishes to print.
One report: A log of the loaded (visible)

welding sequence will be created in a pdf

format.
Selected reports: A log will be created in a
pdf format of every welding sequence which
was logged in the given time period.

All reports: A log will be created in a pdf

format of all saved welding sequences.

un rapport

dans l'intervalle de temps spécifié

tous les protocoles

[ I T T

6 Création de codes-barres pour le

6 Creation of barcodes for the welder
name and building site / construction
project (only for Viwel+)

Nom du soudeur et le chantier/projet
(uniquement Viwel+)

Pour pouvoir imprimer les codes-barres, il
est indispensable d’avoir installé la police
« Codel28 » sur votre ordinateur.

Afin de réduire autant que possible le temps
de saisie tout en permettant une tracabilité
élevée, VIDATA 2.0 offre la possibilité
d‘encoder en codes-barres et d‘imprimer le
nom du soudeur et le nom du
chantier/projet.
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To print barcodes, it is necessary to have
installed the font "Codel28" on your
computer.

In order to keep the data entry time at the
building site as low as possible, and allow a
high degree of traceability, VIDATA 2.0 offers
the option to encode the welder’s name and
the name of the building site / construction
project as a barcode and to print it out.



Ouvrez le programme de création de codes-
barres en cliquant sur le bouton « Barcode ».

Click on the “Barcode” field to open the
barcode program.

File Settings Info
Search
| ’)
Parameter
| °)
Minimum Maximum
Search ‘
")
Barcode

Dans le champ « Welder Name », entrez le
nom du soudeur. Dans le champ de droite a
cOté apparait le code-barres du nom.

Dans le champ « Construction site », entrez le
nom du chantier, du projet ou encore un
numéro d‘attribution. Dans le champ de
droite a cOté apparait le code-barres des
données saisies.

Indication: Aucun saut de ligne n‘est possible !

Enter the name of the welder in the “Welder
name” field. The name appears as a barcode
in the field on the right.

Enter the name of the building site, the
construction project or also a commission
number in the “Construction site” field. The
entered data appear as a barcode in the field
on the right.

Note: It is not possible to use line breaks!

B3 Barcode

Wielder Mame

Consgtruction site

Print

=N R =

En appuyant sur le bouton « Print», vous
pouvez imprimer les codes-barres.
L'impression se lance lorsque vous fermez
cette fenétre.

Le papier (plié) peut étre rangé dans la
pochette qui se trouve a l‘intérieur du
couvercle du VIWEL+.
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The barcodes can be printed out by pressing
the “Print” button.

Printing starts when you close this window.
There is a pouch on the inner side of the
VIWEL+ cover into which the (if necessary
folded) paper can be inserted.
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FR- Retrouvez la liste de nos distributeurs sur www.virax.com

EN — Find the list of our dealers on www.virax.com

IT - Trova il rivenditore Virax piu vicino a te su www.virax.com

ES - Encuentra el listado de distribuidores en www.virax.com

PT - Encontre a lista de nossos revendedores www.virax.com

NL - Vind de lijst van onze resellers www.virax.com

EL - ZupBouleuteite Tn Alota Twv SLAVOUEWY HOG OTO WWW.Virax.com

PL - Liste naszych dystrybutoréw znajdziecie na www.virax.com

DE - Eine aktuelle Liste unserer Handelspartner finden Sie unter www.virax.com
CS - Seznam nasich prodejcl najdete na www.virax.com

RU - Cnncok annepoB Bbl MOXKeTe HaTM Ha caliTe WWW.Virax.com

TR - DistribUtor’ lerimizin listesini, www.virax.com web sitemizden bulabilirsiniz
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